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Bay Networks Software License

This Software License shall govern the licensing of all software provided to licensee by Bay Networks (“Software”). 
Bay Networks will provide licensee with Software in machine-readable form and related documentation 
(“Documentation”). The Software provided under this license is proprietary to Bay Networks and to third parties from 
whom Bay Networks has acquired license rights. Bay Networks will not grant any Software license whatsoever, either 
explicitly or implicitly, except by acceptance of an order for either Software or for a Bay Networks product 
(“Equipment”) that is packaged with Software. Each such license is subject to the following restrictions:

1. Upon delivery of the Software, Bay Networks grants to licensee a personal, nontransferable, nonexclusive license 
to use the Software with the Equipment with which or for which it was originally acquired, including use at any 
of licensee’s facilities to which the Equipment may be transferred, for the useful life of the Equipment unless 
earlier terminated by default or cancellation. Use of the Software shall be limited to such Equipment and to such 
facility. Software which is licensed for use on hardware not offered by Bay Networks is not subject to restricted 
use on any Equipment, however, unless otherwise specified on the Documentation, each licensed copy of such 
Software may only be installed on one hardware item at any time.

2. Licensee may use the Software with backup Equipment only if the Equipment with which or for which it was 
acquired is inoperative.

3. Licensee may make a single copy of the Software (but not firmware) for safekeeping (archives) or backup 
purposes.

4. Licensee may modify Software (but not firmware), or combine it with other software, subject to the provision 
that those portions of the resulting software which incorporate Software are subject to the restrictions of this 
license. Licensee shall not make the resulting software available for use by any third party.

5. Neither title nor ownership to Software passes to licensee.

6. Licensee shall not provide, or otherwise make available, any Software, in whole or in part, in any form, to any 
third party. Third parties do not include consultants, subcontractors, or agents of licensee who have licensee’s 
permission to use the Software at licensee’s facility, and who have agreed in writing to use the Software only in 
accordance with the restrictions of this license.

7. Third-party owners from whom Bay Networks has acquired license rights to software that is incorporated into 
Bay Networks products shall have the right to enforce the provisions of this license against licensee.

8. Licensee shall not remove or obscure any copyright, patent, trademark, trade secret, or similar intellectual 
property or restricted rights notice within or affixed to any Software and shall reproduce and affix such notice on 
any backup copy of Software or copies of software resulting from modification or combination performed by 
licensee as permitted by this license.

Note:  This is Bay Networks basic license document. In the absence of a 
software license agreement specifying varying terms, this license -- or the 
license included with the particular product -- shall govern licensee’s use of 
Bay Networks software.
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Bay Networks Software License (continued)

9. Licensee shall not reverse assemble, reverse compile, or in any way reverse engineer the Software. [Note: For 
licensees in the European Community, the Software Directive dated 14 May 1991 (as may be amended from time 
to time) shall apply for interoperability purposes. Licensee must notify Bay Networks in writing of any such 
intended examination of the Software and Bay Networks may provide review and assistance.]

10. Notwithstanding any foregoing terms to the contrary, if licensee licenses the Bay Networks product “Site 
Manager,” licensee may duplicate and install the Site Manager product as specified in the Documentation. This 
right is granted solely as necessary for use of Site Manager on hardware installed with licensee’s network. 

11. This license will automatically terminate upon improper handling of Software, such as by disclosure, or Bay 
Networks may terminate this license by written notice to licensee if licensee fails to comply with any of the 
material provisions of this license and fails to cure such failure within thirty (30) days after the receipt of written 
notice from Bay Networks. Upon termination of this license, licensee shall discontinue all use of the Software 
and return the Software and Documentation, including all copies, to Bay Networks.

12. Licensee’s obligations under this license shall survive expiration or termination of this license.
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About This Guide

To manage your Bay Networks router or BNX platform, you can use Site 
Manager, a graphical user interface with access to the Bay Networks MIB. For an 
overview of Site Manager, refer to Chapter 1. To use the application, you should 
learn about

• Using Site Manager windows (refer to Chapter 2)

• Performing basic Site Manager functions (refer to Chapter 3)

When you understand how to use Site Manager, you can then move on to the 
following tasks:

• Performing router management with Site Manager (refer to Chapter 1 of 
Managing Routers and BNX Platforms) 

• Configuring protocol services for Bay Networks routers using the Site 
Manager Configuration Manager tool (refer to Configuring Routers or 
Configuring Customer Access and Trunks (BNX Software), depending on the 
type of installed software)

For information about using the Technician Interface instead of Site Manager, 
refer to Using Technician Interface Software. (The Technician Interface is a 
command-line interface you can use as a backup when Site Manager is not 
available.) 

Note: The Site Manager windows shown in this book are from an X Window 
System UNIX environment. Minor variations in screen appearance may occur 
from platform to platform.
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Software Suites

Routing and Switching software is available in the following suites:

• The System Suite includes IP routing, 802.1 Transparent Bridge, Source 
Route Bridge, Translation Bridge, SNMP Agent, Bay Networks HDLC, PPP, 
OSPF, EGP, BGP, and basic DLSw.

• The LAN Suite includes DECnet Phase 4, AppleTalk Phase 2, OSI, VINES, 
IPX, and ATM DXI, in addition to the System Suite.

• The WAN Suite includes ATM DXI, Frame Relay, LAPB, and X.25, in 
addition to the System Suite.

• The Corporate Suite includes the System, LAN, and WAN suites in their 
entirety.

• The ARE ATM Suite provides RFC 1483 and 1577 compliance, ATM UNI 3.0 
signaling, in addition to the LAN Suite.

• The ARE VNR Corporate Suite provides ATM Forum LAN Emulation, in 
addition to the ARE ATM Suite and Corporate Suite.

• The BNX Suite includes IP Routing, SNMP Agent, Bay Networks HDLC, 
PPP, OSPF, EGP, BGP, File-Based Performance Statistics, Frame Relay 
switching, and Frame Relay billing, and selected components from the 
Corporate, ARE ATM, and ARE VNR Corporate suites.

Availability of features and functionality described in this guide depends on the 
suites you are using.

Audience

This guide addresses inexperienced users of Bay Networks Site Manager 
software. Experienced users may also find the guide helpful, to refresh their 
memories.

Before You Begin

Before you use this guide, you must install the Site Manager application using the 
instructions provided in Quick-Starting Routers and BNX Platforms.
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Conventions

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command. 
Example: if command syntax is ping <ip_address>, 
you enter ping 192.32.10.12

bold text Indicates text that you need to enter, command names, 
and buttons in menu paths.
Example: Enter wfsm &

Example: Use the dinfo command. 

Example: ATM DXI > Interfaces > PVCs identifies the 
PVCs button in the window that appears when you 
select the Interfaces option from the ATM DXI menu.

brackets ([ ]) Indicate optional elements. You can choose none, one, 
or all of the options.

italic text Indicates variable values in command syntax 
descriptions, new terms, file and directory names, and 
book titles.

quotation marks (“ ”) Indicate the title of a chapter or section within a book.

screen text Indicates data that appears on the screen. 
Example: Set Bay Networks Trap Monitor Filters

separator ( > ) Separates menu and option names in instructions and 
internal pin-to-pin wire connections. 
Example: Protocols > AppleTalk identifies the 
AppleTalk option in the Protocols menu. 

Example: Pin 7 > 19 > 20

vertical line (|) Indicates that you enter only one of the parts of the 
command. The vertical line separates choices. Do not 
type the vertical line when entering the command.
Example: If the command syntax is 

show at routes | nets, you enter either 
show at routes or show at nets, but not both.
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Acronyms

GAME Gate Access Management Entity

ICMP Internet Control Message Protocol

MIB Management Information Base

MDI multiple document interface

OSI Open Systems Interconnection

RFC Request for Comments

SNMP Simple Network Management Protocol

TCP/IP Transmission Control Protocol/Internet Protocol

TFTP Trivial File Transfer Protocol

UDP User Datagram Protocol

Ordering Bay Networks Publications

To purchase additional copies of this document or other Bay Networks 
publications, order by part number from the Bay Networks Press™ at the 
following telephone or fax numbers:

• Telephone - U.S./Canada 1-888-4BAYPRESS
• Telephone - International 1-510-490-4752
• Fax 1-510-498-2609

You can also use these numbers to request a free catalog of Bay Networks Press 
product publications. 
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Technical Support and Online Services

To ensure comprehensive network support to our customers and partners 
worldwide, Bay Networks Customer Service has Technical Response Centers 
in key locations around the globe:

• Billerica, Massachusetts

• Santa Clara, California

• Sydney, Australia

• Tokyo, Japan

• Valbonne, France

The Technical Response Centers are connected via a redundant Frame Relay 
Network to a Common Problem Resolution system, enabling them to transmit and 
share information, and to provide live, around-the-clock support 365 days a year.

Bay Networks Information Services complement the Bay Networks Service 
program portfolio by giving customers and partners access to the most current 
technical and support information through a choice of access/retrieval means. 
These include the World Wide Web, CompuServe, Support Source CD, Customer 
Support FTP, and InfoFACTS document fax service.
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Bay Networks Customer Service 

If you purchased your Bay Networks product from a distributor or authorized 
reseller, contact that distributor’s or reseller’s technical support staff for assistance 
with installation, configuration, troubleshooting, or integration issues.

Customers can also purchase direct support from Bay Networks through a variety 
of service programs. As part of our PhonePlus™ program, Bay Networks Service 
sets the industry standard, with 24-hour, 7-days-a-week telephone support 
available worldwide at no extra cost. Our complete range of contract and 
noncontract services also includes equipment staging and integration, installation 
support, on-site services, and replacement parts delivery -- within approximately 
4 hours.

To purchase any of the Bay Networks support programs, or if you have questions 
on program features, use the following numbers:

In addition, you can receive information on support programs from your local 
Bay Networks field sales office, or purchase Bay Networks support directly 
from your authorized partner.

Region Telephone Number Fax Number

United States and 
Canada 

1-800-2LANWAN; enter Express Routing 
Code (ERC) 290 when prompted 

(508) 436-8880 (direct)

(508) 670-8766

Europe (33) 92-968-300 (33) 92-968-301

Asia/Pacific Region (612) 9927-8800 (612) 9927-8811 

Latin America (407) 997-1713 (407) 997-1714
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Bay Networks Information Services

Bay Networks Information Services provide up-to-date support information as a 
first-line resource for network administration, expansion, and maintenance. This 
information is available from a variety of sources.

World Wide Web

The Bay Networks Customer Support Web Server offers a diverse library of 
technical documents, software agents, and other important technical information 
to Bay Networks customers and partners.

A special benefit for contracted customers and resellers is the ability to access the 
Web Server to perform Case Management. This feature enables your support staff 
to interact directly with the network experts in our worldwide Technical Response 
Centers. A registered contact with a valid Site ID can

• View a listing of support cases and determine the current status of any open 
case. Case history data includes severity designation, and telephone, e-mail, 
or other logs associated with the case.

• Customize the listing of cases according to a variety of criteria, including 
date, severity, status, and case ID. 

• Log notes to existing open cases. 

• Create new cases for rapid, efficient handling of noncritical network 
situations.   

• Communicate directly via e-mail with the specific technical resources 
assigned to your case.

The Bay Networks URL is http://www.baynetworks.com. Customer Service is a 
menu item on that home page.

Customer Service FTP

Accessible via URL ftp://support.baynetworks.com (134.177.3.26), this site 
combines and organizes support files and documentation from across the 
Bay Networks product suite, including switching products from our Centillion™ 
and Xylogics® business units. Central management and sponsorship of this FTP 
site lets you quickly locate information on any of your Bay Networks products.
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Support Source CD

This CD-ROM -- sent quarterly to all contracted customers -- is a complete Bay 
Networks Service troubleshooting knowledge database with an intelligent text 
search engine.

The Support Source CD contains extracts from our problem-tracking database; 
information from the Bay Networks Forum on CompuServe; comprehensive 
technical documentation, such as Customer Support Bulletins, Release Notes, 
software patches and fixes; and complete information on all Bay Networks 
Service programs. 

You can run a single version on Macintosh Windows 3.1, Windows 95, 
Windows NT, DOS, or UNIX computing platforms. A Web links feature enables 
you to go directly from the CD to various Bay Networks Web pages.

CompuServe

For assistance with noncritical network support issues, Bay Networks Information 
Services maintain an active forum on CompuServe, a global bulletin-board 
system. This forum provides file services, technology conferences, and a message 
section to get assistance from other users.

The message section is monitored by Bay Networks engineers, who provide 
assistance wherever possible. Customers and resellers holding Bay Networks 
service contracts also have access to special libraries for advanced levels of 
support documentation and software. To take advantage of CompuServe’s recently 
enhanced menu options, the Bay Networks Forum has been re-engineered to allow 
links to our Web sites and FTP sites.

We recommend the use of CompuServe Information Manager software to access 
these Bay Networks Information Services resources. To open an account and 
receive a local dial-up number in the United States, call CompuServe at 
1-800-524-3388. Outside the United States, call 1-614-529-1349, or your nearest 
CompuServe office. Ask for Representative No. 591. When you are on line with 
your CompuServe account, you can reach us with the command GO BAYNET. 
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InfoFACTS

InfoFACTS is the Bay Networks free 24-hour fax-on-demand service. This 
automated system has libraries of technical and product documents designed to 
help you manage and troubleshoot your Bay Networks products. The system 
responds to a fax from the caller or to a third party within minutes of being 
accessed.

To use InfoFACTS in the United States or Canada, call toll-free 1-800-786-3228. 
Outside North America, toll calls can be made to 1-408-764-1002. In Europe, 
toll-free numbers are also available for contacting both InfoFACTS and 
CompuServe. Please check our Web page for the listing in your country.

How to Get Help

Use the following numbers to reach your Bay Networks Technical Response 
Center:

Technical Response Center Telephone Number Fax Number

Billerica, MA 1-800-2LANWAN (508) 670-8765

Santa Clara, CA 1-800-2LANWAN (408) 764-1188

Valbonne, France (33) 92-968-968 (33) 92-966-998

Sydney, Australia (612) 9927-8800 (612) 9927-8811

Tokyo, Japan (81) 3-5402-0180 (81) 3-5402-0173
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Chapter 1
Overview of Site Manager

Site Manager is an application you use to configure and manage Bay Networks 
routers. The application runs on PC and UNIX workstations, and you can 
integrate it with many popular Simple Network Management Protocol (SNMP) 
applications, such as the Hewlett-Packard OpenView Network Node Manager.

Refer to this chapter for information on the following subjects:

• The Site Manager Graphical User Interface (see page 1-1)

• Site Manager and the Bay Networks MIB (see page 1-4)

The Site Manager Graphical User Interface

The Site Manager graphical user interface organizes, summarizes, and simplifies 
router information. You configure and monitor Bay Networks routers using Site 
Manager tools. 

You access all Site Manager tools and commands from the main Site Manager 
window (Figure 1-1). This window also displays basic router information such as 
IP address, SNMP community, system name, and Management Information Base 
(MIB) version.
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Figure 1-1. Site Manager Window

You can access the following six submenus from the main menu bar (Figure 1-2):

• File 

• View

• Options

• Tools

• Administration

• Help

Chapter 3 describes the submenus in more detail.
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Figure 1-2. Main Menu Bar and Submenus

Just below the Site Manager main menu bar is a row of five buttons (Figure 1-1) 
that you can use to access certain Site Manager functions. Table 1-1 describes the 
function of each button.
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Site Manager and the Bay Networks MIB

You can access the Bay Networks MIB through Site Manager (Figure 1-3).

The Bay Networks MIB is a hierarchical database of 

• Configuration and statistical objects that the router’s operating system 
(GAME) uses

• Protocol image software that defines, limits, and monitors the behavior of a 
Bay Networks router in your network 

The Bay Networks MIB includes all objects for every protocol that Bay Networks 
routers support. The Bay Networks MIB is a specific extension of the 
Management Information Base II (MIB II) described in Internet Request for 
Comments (RFC) 1213.

Through Site Manager or the Technician Interface, you can

• Read (SNMP GET) the values of many objects in the MIB

• Write (SNMP SET) the values of a smaller subset of objects in the MIB

The GAME operating system also has exclusive read/write access to certain 
objects in the MIB.

* Refer to Managing Routers and BNX Platforms for more details on 
statistics, traps, events, and files.

Table 1-1. Function Buttons

Button Function*

Connection Displays the Router Connection Options window, 
which lets you specify the router you want to connect 
to each Site Manager tool (refer to “Connecting to 
Routers” in Chapter 3)

Statistics Opens the Statistics Manager window

Traps Displays the Trap Monitor window

Events Displays the Events Manager window

Files Displays the Router Files Manager window
1-4 114085 Rev. A
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Figure 1-3. Accessing the Bay Networks MIB

Site Manager user interface

Site Manager SNMP-
based application

SNMP agent
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Use Site Manager or the Technician Interface to save MIB objects and their 
settings in a configuration file; then transfer the configuration file to a router. 
GAME uses the configuration file to create an active MIB that dictates the 
behavior of that router on your network.

Using Site Manager to Manage MIB Objects

Site Manager software enables you to

• Create, retrieve, edit, or delete individual instances (occurrences) of

-- Static configuration objects in the MIB

-- Dynamically updated objects (for example, address caches and real-time 
operational statistics)

• Create, edit, save, copy, or delete configuration files that specify subsets of 
MIB objects and their settings for particular Bay Networks routers in your 
network. 

• Generate ASCII reports from router configuration files.

• Transfer to or from a specific Bay Networks router any configuration file that 
you want to

-- Initialize (boot) on a particular router

-- Edit before initializing on a particular router

• Create, edit, filter, save, or delete your workstation view of certain MIB 
objects. (For example, you can use retrieval filters to display all statistical 
objects that have a particular instance ID.)

Accessing the MIB via SNMP

Every Bay Networks router incorporates an SNMP management agent. The agent 
is a software entity that responds to information and action request messages from 
an SNMP-based manager (your Site Manager workstation). The messages 
exchanged between manager and router SNMP agents in turn enable you to access 
and manage objects in an active or inactive (stored) MIB on a particular router.
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Transferring Files via TFTP

Site Manager uses TFTP to transport files through your high-speed IP network. If 
all IP routing paths between file source and destination are down, you can use the 
xmodem/ymodem capabilities of the Technician Interface (refer to Using 
Technician Interface Software). The xmodem/ymodem protocol is, however, a less 
efficient method for transferring files.

Using the ASCII Version of the Bay Networks MIB

Your Site Manager software provides a directory of ASCII MIB files in ASN.1 
syntax -- each file (identified by a .mib extension) contains a single MIB. You can 
use these files as a reference to MIB objects. You can also compile these files with 
a network management application to provide network management access to Bay 
Networks routers. 

MIB files are found in the \wf\mibs (DOS) or /usr/wf/mibs (UNIX) directory.
For example, the Point-to-Point protocol MIB (ppp) can be found in
/usr/wf/mibs/ppp.mib on a UNIX workstation, or in \wf\mibs\ppp.mib on a PC.
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Chapter 2
Using Site Manager Windows

To use Site Manager, you need to learn about

• Site Manager window types (see page 2-1)

• Site Manager window conventions (see page 2-2)

• Entering data in Configuration Manager windows (see page 2-3)

• Getting help (see page 2-6)

Site Manager Window Types

Every Site Manager window has either a menu bar or function buttons.

A menu bar lets you access additional menus and commands. For example, the 
Configuration Manager menu bar (Figure 2-1) gives you access to the File, 
Options, Platform, Circuits, Protocols, Dialup, Window, and Help menus.

Figure 2-1. Menu Bar

Function buttons let you enter and modify data for a specific function. For 
example, the Circuit List window (Figure 2-2) contains Edit, Delete, and Done 
buttons. You use the Edit button to edit a circuit, the Delete button to delete a 
circuit, and the Done button to close the Circuit List window.
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Figure 2-2. Window with Function Buttons

Site Manager Window Conventions

Site Manager windows use the following conventions:

• Menu bar selections, menu options, and button labels that end with three dots 
(...) display a new window when you select them.

• Menu bar options not followed by three dots and menu options followed by a 
shaded arrow ( ) display a menu or submenu when you select them.

• Button labels not followed by three dots perform a function when you click 
on them.

• Underlined letters in menu bar options and menu options identify keyboard 
shortcuts. 

-- If you are using a Sun or IBM keyboard, hold the diamond key (on either 
side of the space bar) and press the key underlined in the menu option to 
select that option. 

-- If you are using a PC keyboard, hold the Alt key and press the key 
underlined in the menu option to select that option.
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• Use the arrow keys on the keyboard to scroll up, down, right, or left through 
the menu bar and menu options.

• The PF number in a menu option identifies the program function key shortcut. 
This number appears to the right of an option in a menu (refer to Figure 1-2).

• Menu options are gray when they are not active for a particular window.

• Some Site Manager windows have vertical scroll bars at the right side of the 
window. You can view the entire contents of a window using the scroll bar.

Entering Data in Configuration Manager Windows

The Configuration Manager is the main tool you use to manage your router 
configurations. You access the Configuration Manager from the Tools menu on the 
Site Manager main menu bar. 

When you configure a router, you need to enter values for parameters in the 
Configuration Manager windows. In some windows, you can choose values from 
a list of settings (refer to “Choosing Values for Parameters from a List of 
Settings”). In other windows, you need to enter values with the keyboard (refer to 
“Entering Parameters with the Keyboard”). If you need to know how to view help 
about a parameter, refer to “Getting Help with Parameters.”

Note: Site Manager is not case-sensitive. You can enter keyboard commands 
in either uppercase or lowercase letters.

Caution: When you exit a Site Manager window on the PC, always use the 
appropriate Site Manager button or menu. Do not exit a Site Manager window 
by using the Windows close command. If you use the Windows close 
command, you may affect Site Manager operation, in which case you need to 
restart the program.
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Choosing Values for Parameters from a List of Settings

Some Configuration Manager windows allow you to choose values for parameters 
from a list of settings. Such Configuration Manager windows contain a Values 
button in the vertical list of buttons in the top right corner of the window. For 
example, the Edit SNMP Global Parameters window (Figure 2-3) contains a 
Values button.

Figure 2-3. Edit SNMP Global Parameters Window

To view the list of settings for a field:

1. Place the cursor in the field.

2. Click on Values. 

Example

Suppose you click in the Enable field in the Edit SNMP Global Parameters 
window (Figure 2-3). If you then click on Values, a Values Selection window 
appears (Figure 2-4).
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Figure 2-4. Values Selection Window

To choose a value:

1. Click on the diamond to the left of the value.

2. Click on OK.

The parameter you selected appears in the appropriate field.

To exit the Values Selection window without choosing a value, click on the Cancel 
button.

Entering Parameters with the Keyboard

You need to use the keyboard to enter data in some fields. Site Manager offers 
some shortcuts you can use to add or replace data with the keyboard.

To replace data in a field:

1. Use the mouse to select the existing data entry in the field. 

• Double-click on a word to select the word only.

• Triple-click on a word to select the entire field.

2. Use the keyboard to enter data. 

The data you enter replaces the entry you selected.

Note: You must close a Values Selection window before you can view possible 
values for other parameters.
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To add or overwrite data in a field:

1. Position the cursor in the field.

2. Toggle the insert key to either insert or overwrite mode.

• When you enter data in insert mode, the cursor appears as an I ( ), and 
your entry is added to the existing entry. 

• When you enter data in overwrite mode, the cursor appears as a block 
( ), and your entry overwrites the existing entry.

3. Use the keyboard to enter data.

Getting Help

Site Manager offers two types of Help facilities:

• Help with a window

• Help with a parameter in a Configuration Manager window

Getting Help with Site Manager Windows

Windows that offer help have a Help button in the horizontal list of buttons near 
the bottom of the window. For example, the Trap Configuration window 
(Figure 2-5) contains such a Help button.
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Figure 2-5. Trap Configuration Window

To get help about a window, click on Help. For example, if you click on Help in 
the Trap Configuration window, a Help window (Figure 2-6) appears.

Figure 2-6. Help Window

To exit the Help window, click on OK.
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Getting Help with Parameters

Configuration Manager windows that offer help on parameters contain a Help 
button in the vertical list of buttons in the top right corner of the window. For 
example, the Edit SNMP Global Parameters window (refer to Figure 2-3) contains 
such a Help button.

To get help about a parameter:

1. Place the cursor in the field for which you want help.

2. Click on Help. 

For example, suppose you click in the Enable field in the Edit SNMP Global 
Parameters window (refer to Figure 2-3).

If you then click on Help, a Help window appears (Figure 2-7).

Figure 2-7. Help with Parameters

Use the scroll bar on the right side of the screen to see the entire help text. Click 
on OK to close the Help window.

Note: You must close a Help window before you can get help with other 
parameters.
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Chapter 3
Performing Basic

Site Manager Operations

Basic operations you perform with Site Manager include

• Starting Site Manager (see page 3-1)

• Connecting to routers (see page 3-2)

• Determining Site Manager version (see page 3-5)

• Starting Site Manager tools (see page 3-6)

• Exiting Site Manager tools (see page 3-6)

• Exiting Site Manager (see page 3-7)

Starting Site Manager

You can start Site Manager from a UNIX or DOS workstation.

UNIX

Start the Site Manager application as follows:

1. Log in to a user account that recognizes Site Manager software.

2. Start the windowing environment. 

Note: Before you attempt to start Site Manager, you must install the software 
according to the instructions in Quick-Starting Routers and BNX Platforms.
114085 Rev. A 3-1



Using Site Manager Software
An example of a windowing environment is X Windows. Refer as necessary 
to the UNIX workstation user documentation.

3. Change to a directory where you want to store configuration files. 

4. Enter wfsm &

Site Manager starts and the Router Connection Options window (Figure 3-1) 
appears. Proceed to the section “Connecting to Routers.”

DOS (Disk Operating System)

Start the Site Manager application as follows:

1. Start Windows.

Enter the following command after the DOS prompt:

win

The Program Manager window appears.

2. Double-click on the Site Manager program group.

The Site Manager program group opens, displaying several icons.

3. Double-click on the PC/Site Manager icon. 

The Router Connection Options window appears. Proceed to the next section, 
“Connecting to Routers.”

Connecting to Routers

When you activate Site Manager, the Router Connection Options window appears 
(Figure 3-1).

Note: Do not attempt to start Site Manager in the /usr/wf directory or in any 
other directory for which Site Manager does not have write-access privileges.
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Figure 3-1. Router Connection Options Window

The Router Connection Options window lets you choose the Bay Networks router 
you connect to each Site Manager tool. You can open a window for each tool and 
connect a different router to each one. In this way, you can manage several Bay 
Networks routers at the same time.

You need to complete each field (or use defaults) in this window. Refer to 
Table 3-1 for a description of the fields in this window.

Table 3-1. Values for the Router Connection Options Window 

Field Description

Node Name/IP 
Address

Enter the host name or IP address of the Bay Networks router you want 
to manage. You can use the host name only if it is in the workstation’s 
host file.
The IP address you enter becomes the default router connection 
address. When you open new tool windows and select Options > 
Router Connection, the Router Connection Options window displays 
this address.

Identity
(community)

Enter the SNMP community name you want Site Manager to use when 
communicating with the router.* 
The community must have read/write access to the Bay Networks 
router you want to reconfigure using the Configuration Manager tool.

(continued)
114085 Rev. A 3-3



Using Site Manager Software
After you complete the fields in the Router Connection Options window, click on 
OK. The Site Manager window appears (Figure 3-2).

Figure 3-2. Site Manager Window

* On any router that is not configured with a valid SNMP community, Site Manager configures 
a “public” community with a wildcard manager (using an IP address of 0.0.0.0). This ensures 
that Site Manager can access the router. You should reconfigure the “public” community, with 
universal access limited to read-only privileges. For more information, refer to Configuring 
SNMP, BOOTP, DHCP, and RARP Services.

Timeout 
(seconds)

Enter the number of seconds Site Manager should wait for a response 
from the Bay Networks router after it issues an SNMP SET or GET 
before reissuing the command.
The default value is 5 seconds. You can specify a value from 1 to 300.

Retries (per 
request)

Enter the number of times you want Site Manager to reissue a 
command when the Bay Networks router does not respond.
The default value is 3. You can specify a value from 0 to 30.

Table 3-1. Values for the Router Connection Options Window (continued)

Field Description
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Determining Site Manager Version

To determine which version of Site Manager you are running, select 
Help > Site Manager Version from any window. The Version window appears 
(Figure 3-3).

Figure 3-3. Version Window

The Description and MIB Version fields in the Site Manager window (Figure 3-2) 
display the router software version. Ensure that the version of Site Manager is 
compatible with the version of the router software by comparing the version 
numbers to those on any Bay Networks software product from that release. For 
example, Site Manager Software Version 1.70 is compatible with Router Software 
Version 7.70, as the title page of a software manual from that release indicates.

Note: Site Manager on a PC uses the Multiple Document Interface (MDI) 
Windows standard. (The Windows title bar appears above every PC Site 
Manager window.)
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Starting Site Manager Tools

To use a Site Manager tool, select the appropriate option from the Tools menu in 
the Site Manager window (refer to Figure 1-2). Site Manager tools include the 
following:

• Configuration Manager

• Statistics Manager

• Trap Monitor

• Router Files Manager

• Report Generator 

• Events Manager

• Image Builder 

• Router Redundancy

Refer to Appendix A for information on how to start tools from the UNIX 
command line.

Exiting Site Manager Tools

To exit a Site Manager tool:

1. Access the main window for the tool.

2. Select File > Exit. 

A confirmation window appears.

3. Click on OK.

All windows associated with the tool close when you shut down the application. 

Caution: On a PC, do not exit a Site Manager tool by using the Windows 
close command. If you use the Windows close command, you may affect Site 
Manager operation, in which case you need to restart the program. To exit a 
tool, be sure to follow the instructions below.
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Exiting Site Manager

To exit Site Manager, complete the following steps:

1. Access the main Site Manager window (Figure 3-2).

2. Select File > Exit.

A confirmation window appears.

3. Click on OK.

When you shut down Site Manager on a UNIX system, only those tools and 
associated windows you started from the Site Manager window shut down. Tools 
started from the command line remain open.

When you shut down Site Manager on a DOS system, a window indicates which 
Site Manager tools and associated windows are still open. You cannot shut down 
Site Manager until you close these windows.

Caution: On a PC, do not exit Site Manager by using the Windows close 
command. If you use the Windows close command, you may affect Site 
Manager operation, in which case you need to restart the program. To exit Site 
Manager, be sure to follow the instructions below.
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Appendix A
Using UNIX Commands

to Start Site Manager

You can directly access Site Manager tools from a command line on a UNIX 
workstation. Bay Networks recommends that only experienced Site Manager 
operators use this approach.

Table A-1 lists the commands for starting Site Manager tools from a UNIX 
command line. You can add startup options to these commands to override Site 
Manager default settings. Table A-2 describes the available options. 

To start a Site Manager tool from the UNIX command line, follow these 
directions:

1. Access an X window on your UNIX workstation.

2. Enter one of the commands from Table A-1 and the command options 
you want from Table A-2.

3. Append the command with a space and an ampersand (&).

This action ensures that you can continue to enter commands in the command 
line window while the tool is running. 

Note: To start the Image Builder tool, type builder at the command line. You 
cannot use the command options listed in Table A-2 with the builder 
command.
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Example

You can enter the following command to start the Configuration Manager with a 
connection to IP address 192.32.4.2 and an SNMP timeout of 10 seconds:

wfcfg -a 192.32.4.2 -t10 &

The tool’s window appears, displaying the IP address and the community name of 
the router you specified.

Table A-1. Site Manager Startup Commands

Command Function

wfsm Starts Site Manager, which establishes a 
connection with the router

wfcfg Starts the Configuration Manager

wflog Starts the Events Manager

wftraps Starts the Trap Monitor

wfrfs -a <SNMP agent IP address> Starts the Router Files Manager, which 
establishes a connection with the router 

wfstats -a <SNMP agent IP address> Starts the Statistics Manager, which establishes 
a connection with the router

wflaunch -a <SNMP agent IP address> Displays an individual statistics window

Note: You must always specify the -a  <SNMP agent IP address>  startup 
option for the wfrfs, wfstats, and wflaunch commands. You need only specify 
this option for other commands when you want to connect to a router.
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Table A-2. Site Manager Startup Command Options  

Startup Option
Startup 
Commands

Function
Default 
Setting

Example

-c <SNMP 
community> 

All Specifies the SNMP 
community string.

public wfsm -c Sitemgr

-a <SNMP agent IP 
address>

Mandatory for 
wfrfs,
wfstats, and
wflaunch.
Use with other 
commands 
when you want 
to connect to a 
router.

Specifies the SNMP 
agent’s IP address.

none wfstats -a 192.32.4.2

-m <SNMP MIB 
definitions file>

All Specifies the MIB 
definitions file in the 
path /usr/wf/lib.

WFMIB.defs wfcfg -m mymib.defs

-r <SNMP retry 
count>

All Specifies the 
number of SNMP 
retries.

3 wfrfs -r 5

-t <SNMP timeout> All Specifies the 
number of seconds 
for the SNMP 
timeout.

5 wflog -t 10

-s <SNMP 
destination port>

All Specifies the UDP 
port for the SNMP 
destination. The 
default setting 
causes the 
application to 
retrieve the SNMP 
destination port from 
/etc/services.

0 wftraps -s 1161

(continued)
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-e <SNMP trap 
port>

wfsm
wftraps 

Specifies the UDP 
port on which the 
Trap Monitor should 
listen for SNMP 
traps. The default 
setting causes the 
application to 
retrieve the SNMP 
trap port from
/etc/services.

0 wftraps -e 1161

-v <config volume> wfsm 
wfcfg 

Specifies the volume 
for remote 
configuration file 
access.

2 wfsm -v 3

-f </path/> <file> wfcfg 
wflaunch

Specifies the 
configuration or 
statistics screen 
filename.

2 wfcfg -f /wf/file.cfg

-o <config mode> wfcfg Specifies the 
configuration mode: 
local, remote, or 
dynamic.

local wfcfg -o remote

-p wflaunch Displays an 
individual statistics 
window in preview 
mode (without 
displaying data).

10 wflaunch - p 1

Table A-2. Site Manager Startup Command Options  (continued)

Startup Option
Startup 
Commands

Function
Default 
Setting

Example
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